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1 Overview

Topics Of This Chapter

§ Introduction

§ Hardware Features

1.1 Introduction

This topic includes:

§ MADRIX NEBULA

MADRIX NEBULA

MADRIX NEBULA is a versatile interface to directly control a wide range of digital LEDs.

The MADRIX NEBULA directly connects to your LED pixels. This advanced SPI decoder receives control data

over Ethernet network or USB and is built to provide excellent image quality.
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1.2 Hardware Features

This topic includes:

§ Using A 3rd-Party Controller

§ Supported LEDs

§ Putting The Device Into Operation

§ LED Status Codes

§ Automatic HTP Merging

§ Daisy-Chain Support

§ Reset To Factory Default Settings

§ Initiate Poll

Using A 3rd-Party Controller

MADRIX NEBULA is a standard network node. Because of this, you can use the device with applications,

consoles, desks, or controllers that are compatible with Art-Net or Streaming ACN [sACN] to distribute data

via Ethernet network.

Supported LEDs

MADRIX NEBULA supports the following LEDs [as of December 2024]:

§ APA101

§ APA102

§ APA104

§ APA106

§ FW1935

§ GS8206

§ GS8207

§ GS8208

§ GW6201

§ GW6205

§ LB1908

§ LPD1882S

§ UCS512B3

§ UCS1903

§ UCS2603

§ UCS2903

§ UCS2904

§ UCS2904B

§ UCS5603

§ UCS5603A

§ UCS7604

§ UCS8903

§ UCS8904

§ UCS9812S
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§ LPD6803

§ LPD8806

§ MBI6023

§ MBI6024

§ MBI6120

§ MY9291

§ P9883

§ SJ1221

§ SK6112

§ SK6805

§ SK6812

§ SK6813

§ SK6822

§ SK9816

§ SK9822

§ SK9826

§ SM16703

§ SM16704

§ SM16716

§ TLC5973

§ TLS3001

§ TLS3008

§ TM1803

§ TM1804

§ TM1809

§ TM1812

§ TM1814

§ TM1829

§ TM1934

§ VS17822

§ WS2801

§ WS2803

§ WS2811

§ WS2811F

§ WS2811M 

§ WS2811S

§ WS2812

§ WS2812B

§ WS2812C

§ WS2813

§ WS2814

§ WS2814F

§ WS2815

§ WS2818

§ WS2818M

§ WS2821

§ WS2821 Addressing

§ WS2822S

§ WS2822S Addressing

Note: UCS512D cannot be controlled with MADRIX NEBULA, but it can be controlled with MADRIX STELLA

(with its RDM functionality disabled).

 

The protocols above currently have the following frequencies implemented and available [as of May 2024

with firmware 6.04]:

Protocol Frequency Special Remarks

§ APA101 § 24 MHz
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§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ APA102 § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ APA104 § 800 kHz

§ 585 kHz

§ APA106 § 585 kHz

§ FW1935 § 800 kHz

§ GS8206 § 800 kHz

§ GS8207 § 800 kHz

· GS8208 § 800 kHz

§ GW6201 § 800 kHz

§ GW6205 § 800 kHz

§ 400 kHz

§ LB1908 § 800 kHz

§ LPD1882S § 1 MHz

§ LPD6803 § 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ LPD8806 § 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ MBI6023 § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz
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§ 2 MHz

§ 1 MHz

§ MBI6024 § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ MBI6120 § 1.2 MHz

§ 800 kHz

§ 400 kHz

§ 1.2 MHz

§ 800 kHz

§ 400 kHz

§ 1.2 MHz

§ 800 kHz

§ 400 kHz

         

         

         

§ Limit 66 %

§ Limit 66 %

§ Limit 66 %

§ Limit 33 %

§ Limit 33 %

§ Limit 33 %

§ MY9291 § 16 Bit

§ 8 Bit

§ P9883 § 800 kHz

§ SJ1221 § 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 

§ MIN

§ SK6112 § 800 kHz

§ SK6805 § 800 kHz

§ SK6812 § 800 kHz

§ SK6813 § 800 kHz

§ SK6822 § 800 kHz

§ SK9816 § 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 

§ MIN

§ SK9822 § 24 MHz

§ 12 MHz

§ 8 MHz
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§ 4 MHz

§ 2 MHz

§ 1 MHz

§ SK9826 § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ SM16703 § 800 kHz

§ SM16704 § 800 kHz

§ SM16716 § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ TLC5973 § 3 MHz

§ 2 MHz

§ 1 MHz

§ 800 kHz

§ 400 kHz

§ TLS3001 § 2 MHz

§ 1 MHz

§ 800 kHz

§ 400 kHz

§ Linear

§ Linear

§ Linear

§ Linear

§ TLS3001 § 2 MHz

§ 1 MHz

§ 800 kHz

§ 400 kHz

§ Quadratic

§ Quadratic

§ Quadratic

§ Quadratic

§ TLS3008 § 1 MHz

§ 800 kHz

§ 400 kHz

§ TM1803 § 500 kHz

§ TM1804 § 800 kHz

§ 400 kHz

§ TM1809 § 800 kHz

§ TM1812 § 800 kHz
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§ TM1814 § 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 

§ MIN

§ TM1829 § 1.6 MHz

§ 1.6 MHz

§ 1.6 MHz

§ 1.6 MHz

§ 1.6 MHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 100 % 

§ 75 %  

§ 50 %  

§ 25 %  

§ MIN

§ 100 %

§ 75 %

§ 50 %

§ 25 %

§ MIN

§ TM1934 § 800 kHz

§ UCS512B3 § 750 kHz

§ 500 kHz

§ 250 kHz

§ UCS1903 § 800 kHz

§ 400 kHz

§ UCS2603 § 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 

§ MIN

§ UCS2903 § 800 kHz

§ 400 kHz

§ UCS2904 § 800 kHz

§ UCS2904B § 800 kHz

§ UCS5603 § 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 

§ MIN

§ UCS5603A § 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 
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§ 800 kHz § MIN

§ UCS7604 § 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz

§ 800 kHz, 16 Bit

§ 800 kHz, 16 Bit

§ 800 kHz, 16 Bit

§ 800 kHz, 16 Bit

§ 800 kHz, 16 Bit

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 

§ MIN

§ 100 %

§ 75 % 

§ 50 % 

§ 25 % 

§ MIN

§ UCS8903 § 800 kHz

§ 800 kHz § 16 Bit Native

§ UCS8904 § 800 kHz

§ 800 kHz § 16 Bit Native

§ UCS9812S § 1.1 MHz

§ 1.1 MHz

§ 1.1 MHz

§ 1.1 MHz

§ 1.1 MHz

§ 100 %

§ 75 %

§ 50 %

§ 25 %

§ MIN

§ VS17822 § 800 kHz

§ WS2801 § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ WS2803 § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ WS2803 Reversed § 24 MHz

§ 12 MHz

§ 8 MHz

§ 4 MHz

§ 2 MHz

§ 1 MHz

§ Reversed

§ Reversed

§ Reversed

§ Reversed

§ Reversed

§ Reversed

§ WS2811 § 800 kHz
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§ 400 kHz

§ WS2811F § 800 kHz

§ WS2811M § 800 kHz

§ 400 kHz

§ WS2811S § 800 kHz

§ 400 kHz

§ WS2812 § 800 kHz

§ WS2812B § 800 kHz

§ WS2812C § 800 kHz

§ WS2813 § 800 kHz

§ WS2814 § 800 kHz

§ WS2814F § 800 kHz

§ WS2815 § 800 kHz

§ WS2818 § 800 kHz

§ WS2818M § 800 kHz

§ WS2821 § 750 kHz

§ 500 kHz

§ 250 kHz

§ Addressing

§ WS2822S § 750 kHz

§ 500 kHz

§ 250 kHz

§ Addressing

Putting The Device Into Operation

1] Connecting Your LEDs

Please see the MADRIX NEBULA Technical Manual & Quick Start Guide on how to connect your LEDs to

MADRIX NEBULA. 

»help.madrix.com

http://help.madrix.com/
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2] Connecting To Power And Data

Please see the MADRIX NEBULA Technical Manual & Quick Start Guide on how to connect to power and

data. 

»help.madrix.com

3] Setting The Output Protocol

In order to put MADRIX NEBULA fully into operation, it is necessary to set the correct output

protocol according to the LEDs you have connected.

Learn more:

§ Configuration Using A Web Browser 

4] Setting The Network Data Source

Make sure to set the correct network data source and other settings according to the

controller/sender you want to use.

Learn more:

§ Configuration Using A Web Browser

LED Status Codes

The following tables describe the LED status codes of the device.

STATUS STATUS LED POWER

Powered off Power not connected. > The device has no power.

http://help.madrix.com/
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Permanently green Connected to power. > The power is on.

Blinking green Bootloader activated. > Reset the device to factory default settings.

STATUS STATUS LED USB

Powered off USB not connected.

Red +
blinking green

Communicating over USB.
> Sending or receiving data over USB. The USB port works.

Fading between
red +green

Connected to USB; Drivers installed correctly.
> No data is sent over USB.

Orange Connected to USB; No drivers installed.
> Reinstall software and drivers or try a different USB port.

STATUS STATUS LED PORT 1 STATUS LED PORT 2

Powered off No data is sent. No data is sent.

Blinking green Sending data to Port 1.
> The output port works.

Sending data to Port 2.
> The output port works.

STATUS STATUS LEDS ETHERNET PORTS

Green off 10 MBit/s connected.

Green on 100 MBit/s connected.

Orange on Network connected.

Orange blinking Sending or receiving data. > The Ethernet port works.

Automatic HTP Merging

Overview

§ MADRIX NEBULA features automatic HTP merging from 2 Ethernet sources.

[Usually, the first source will be MADRIX 5. The second source could be a console, for example.]

§ Data from both source will be merged together and sent out as 1 signal. This happens across all 8

output ports and by using the HTP principle.
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§ HTP - Is the acronym for Highest Takes Precedence. Data from both sources will be compared for each

individual channel. The higher value wins per channel.

§ Sources can be:

- 1x Art-Net + 1x Art-Net

- 1x Art-Net + 1x sACN

- 1x sACN + 1x sACN

Configuration And Recommendations When Merging Art-Net

1] Correctly set up and enable Art-Net for each source.

2] Make sure to activate ArtSync for Art-Net in MADRIX 5. Learn more Sync Mode 

3] Make sure that MADRIX 5 has a lower IP address compared to the second source.

[E.g., 2.0.0.1 compared to 2.0.0.20]

4] Always use Unicast Mode in MADRIX 5 to directly send data to the correct IP addresses of your

MADRIX NEBULA devices. 

[It is not recommend to have any of the two sources or any other source in the network to send data

via Broadcast Mode.]

Daisy-Chain Support

§ MADRIX NEBULA features 2 separate Ethernet network ports. Either one is fully functional for IN and

OUT. They can also be used for the data connection in daisy-chain manner without using a separate

network switch or router.

§ When using 4 universes per port: We recommend to connect a maximum of 40 units after one another

in a row.

§ When using 6 universes per port: We recommend to connect a maximum of 26 units after one another

in a row.

§ Requirements in both cases: Using Art-Net in Unicast Mode or Streaming ACN Multicast at a max. data

rate of 50 FPS / 20 ms without any additional devices connected to this network line.

§ In total, a maximum of 320 universes should be connected in a row in this way.

§ In the MADRIX 5 Software, we highly recommend to activate ArtSync for excellent image quality.
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Reset To Factory Default Settings

In rare cases you might need to do a reset to factory default settings, for example to reset to the device to

its default IP address as shown on the side of the device:

Reset Via Reset Button

§ 1] Disconnect all connections from the device [power, data, LEDs].

§ 2] Use a suitable tool to press the reset button [between Port 1 and Port 2].

§ 3] Continue to press the reset button and supply power again over 'Power' or USB.

§ 4] Continue to press the reset button and wait until all status LEDs of the device flash repeatedly or

wait 10 seconds.

[Simply repeat these steps should the process fail.]

Reset Via Ethernet [Web Configuration]

§ 1] Connect MADRIX NEBULA to power.

[Please see safety instructions in the MADRIX NEBULA Technical Manual & Quick Start Guide!]

§ 2] Connect MADRIX NEBULA and your computer to the same Ethernet network.

§ 3] Assign correct network settings for your computer in the operating system. 

[Recommended default settings: IP address 10.0.0.1 / Subnet mask 255.0.0.0]

§ 4] Open your web browser and enter the IP address of MADRIX NEBULA. The built-in web configuration

tool will be launched.

[You can find the default IP address on the side of the device.]

§ 5] Click Reset

Learn more »Web Configuration [Ethernet]

Reset Via USB Or Ethernet [MADRIX HARDWARE MANAGER]

§ 1] Connect MADRIX NEBULA to power.

[Please see safety instructions in the MADRIX NEBULA Technical Manual & Quick Start Guide]

§ 2] Connect MADRIX NEBULA to your computer via USB or Ethernet.

[You can use the provided USB cable or a separate network cable is required.]
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§ 3] Start the separate MADRIX HARDWARE MANAGER

[In Windows 10, go to Start > MADRIX HARDWARE MANAGER > MADRIX HARDWARE MANAGER

§ 4] Select a device/devices in the list.

§ 5] Right Mouse Click > Restore Factory Default Settings

[Wait for the reset process to end [usually it takes only seconds.]

Learn more »MADRIX HARDWARE MANAGER [USB / Ethernet]

Initiate Poll

During normal operation, quickly pressing the Reset button sends an Art-Net PollReply and a MADRIX

PollReply for device discovery to the network.
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2 Device Configuration

This topic includes:

§ Overview

§ Topics Of This Chapter

Overview

§ Web Configuration: The built-in web configuration is the main way of configuring your devices. By

using a standard web browser, you gain quick access to all device settings.

§ MADRIX HARDWARE MANAGER: This software is available separate. You can use it specifically to

manage MADRIX hardware products, including their basic configuration and firmware updates.

Topics Of This Chapter

§ Web Configuration [Ethernet]

§ MADRIX HARDWARE MANAGER [USB / Ethernet]

2.1 Web Configuration [Ethernet]

This topic includes:

§ Configuration Using A Web Browser

Configuration Using A Web Browser

When connected to Ethernet network, you can easily configure MADRIX NEBULA using the built-in web

configuration page.

You have 2 options to access the web interface. Both, NEBULA and your computer, need to be in the same

network.

A] Using a standard web browser:
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§ Connect MADRIX NEBULA and your computer to the same network.

§ Assign correct network settings for your PC in the Windows operating system. 

[Recommended default settings: IP address 10.0.0.1 / Subnet mask 255.0.0.0]

[Please note: Your devices and the sender, such as the PC that runs MADRIX 5, need to have the

same subnet mask!]

§ Open your web browser and enter the IP address of MADRIX NEBULA.

[You can find the default IP address on the back side of the device.]

§ The web configuration page will be launched. Now, you have access to various information and

settings.

B] Using the MADRIX 5 Software:

§ Connect MADRIX NEBULA and your computer to the same network.

§ Assign correct network settings for your PC in the Windows operating system. 

[Recommended default settings: IP address 10.0.0.1 / Subnet mask 255.0.0.0]

[Please note: Your devices and the sender, such as the PC that runs MADRIX 5, need to have the

same subnet mask!]

§ Go to the menu Tools > MADRIX Device Configuration...

[Keyboard shortcut: Ctrl+Alt+L]

§ Select your MADRIX NEBULA device in the list.

§ Click 

§ Your default web browser will open and the web configuration page will be launched. Now, you have

access to various information and settings.
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Device Name - Allows you to change the main label of the device by entering a name.

The default setting is MADRIX NEBULA.

§ This refers to LongName within Art-Net with a maximum of 64 characters.



[Part 2] Device Configuration

//22www.madrix.com

MADRIX NEBULA User Manual

§ This refers to DEVICE_LABEL within RDM with a maximum of 32

characters.

§ This refers to Source Name within sACN with a maximum of 63 characters.

§ This refers to the communication with the MADRIX 5 Software over

Ethernet network or USB.

Short Name (Art-Net) - Allows you to change the ShortName identifier used

by Art-Net. The default setting is the IP address of the device.

Confirm with Set

Network Address You can change the basic network device settings. 

Confirm with Set

§ IP Address

§ Subnet Mask

[Note: Your devices and the sender, such as the PC that runs MADRIX 5,

need to have the same subnet mask!]

Network To SPI Output This section shows specific settings for the output ports [Port 1 and Port 2].

Universe Count - Defines the number of active output universes. 

§ You can set the value separately for each of the two ports.

§ You can disable universes of the port by lowering the number.

[Art-Net PollReply still responds with the maximum available amount of

universes to not invalidate the BindIdx, but the state of the polls are

changed from Output to None.]

[Universes will be disabled from right to left.]

§ Firmware 5.XX: A maximum of 4 universes/minimum of 1 universes can

be sent per port. The default value is 4.

§ Firmware 6.00: A maximum of 6 universes/minimum of 1 universes can

be sent per port. The default value is 4.

§ Note: The fewer universes are assigned, the less data needs to be

processed, and the higher the output frame rate can be.

§ Note: An output frame rate by the device of at least 33 FPS is

recommended for smooth visuals. Learn more below: FPS.

§  Sets the value of the first port for all ports.
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Assigned Network Universes - Defines the assignment of universes.

§ By default, universes 1 - 4 are assigned to Port 1, and universes 5 - 8 are

assigned to Port 2.

§ If you are broadcasting data for a large number of Universes [using

Broadcast Mode instead of Unicast Mode] with MADRIX 5 or a 3rd-party

controller, you can assign different DMX universes to each device with

these settings. Each MADRIX NEBULA will then only receive data from the

specific universe and send it to its specified output port.

§ Example: You can set up that NEBULA #1 only listens to universe 1 - 8,

while NEBULA #2 listens to universe 9 - 16, and NEBULA #3 listens to

universe 17 - 24, and so on.

§  Automatically and consecutively numbers all universes in

ascending or descending order based on the first port.

FPS - Shows the possible output frame rate that can be achieved with the

current settings per port (as they are set in the web configuration). 

§ Not recommended: 32 FPS 

§ Recommended: 33 FPS

§ Best performance: 100 

Settings — The shown FPS is being calculated according to the following

settings:

§ Number Of Assigned Network Universes Per Port

[The fewer universes are assigned, the less data needs to be processed,

and the higher the output frame rate can be.]

§ Output Protocol

[Different protocols work differently.]

§ Frequency Of The Output Protocol

[Higher clock speeds allow for higher output frame rates.]

Data Input — The actual live output depends on the data sent to the device:
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§ Art-Net/sACN over network allow for the highest data rates, unlike USB. 

§ If the received data rate (sent to the device from your control software or

console, for example) is lower than the calculated FPS, the actual output

frame rate will also be lower (FPS then represents a maximum value).

§ If less universes are received than are assigned, the actual output frame

rate could be higher in practice (FPS then represents a minimum value).

§ If the received data rate is higher than the calculated FPS, the actual

output frame rate will be capped (FPS then represents a maximum

value).

§ If the network source is missing, the functionality of In Case Of Missing

Network Data becomes active with its different options and ways of

functioning (FPS then represents a maximum value).

ArtRdm (Act As RDM Responder) - Enables ArtRdm to be able to reply to

RDM requests by an RDM controller as an RDM responder over Art-Net with

status and sensor data. This enables monitoring of the device via MADRIX

RADAR. The option is disabled by default.

MADRIX NEBULA mainly provides data regarding:

§ Input Voltage [Power]

§ Port 1 Voltage

§ Port 2 Voltage

§ USB Power

§ Temperature

§ Device Model [incl. Hardware Revision]

§ Software Version [of the Firmware and Bootloader]

§ And device information, such as IP Address, Device Short/Long Name, etc.

§ Learn more Using RDM And MADRIX RADAR 
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Device Accepts Network Data From - Defines the data source for the device.

Choose from the following options:

§  Art-Net

§ Streaming ACN

§ Art-Net And sACN

SPI Output

Configuration

Output Protocol - In order to put MADRIX NEBULA fully into operation, it is

necessary to set the correct output protocol according to the LEDs you have

connected. You can set it up here.

§ Choose a signal frequency according to the specifications of your

LEDs.

§  If you do not have this information, choose a signal frequency that

works for your LEDs. If the refresh rate is set too high, you will

usually notice that your LEDs flicker uncontrollably. If that is the case,

choose a lower frequency.

§ Certain LEDs need to be addressed first. If your LEDs need to be

addressed and have not been addressed yet, please address them

first. See Please Note Regarding LEDs That Need Be Addressed First

below.

§  Sets the value of the first port for all ports.

Channel Offset - Allows you to shift the received universes [2048 DMX

channels] per port if required.

§ This will modify the output.

§ +1 To +511 - Adding a positive channel offset will add another universe

before the first universe 

- This universe will include the number of channels as defined by the

offset.

- These channels are sent with a value of 0.

§ -1 To -511 - Adding a negative channel offset will shift the received

channels to lower channel numbers.

- That means that the first channels will be removed. 

- A Channel Offset can have several advantages, such as splitting a single

universe onto the two ports.

For example, your sender sends 3 1/2 universes and some of those LEDs
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are connected on the second port. On Port 1, you would like to send 3

universes and 45 channels and on Port 2, you would like to send another

150 channels from universe 3. Then, you can set the Start Channel of Port

2 to 46 and universe 3.

Or you could use it to align two pixel tapes that are mounted closely

together, but are positioned slightly different, for example.

§  Sets the value of the first port for all ports.

Channel Order - Allows you to change the order of [color] channels for the

output. 

§ Defines how received channels are newly ordered.

§ Example 1: If you receive channels 1-2-3 [i.e. RGB, for example], the

setting 1-2-3-(4) will send it out as R-G-B. In contrast, the setting 3-2-1

would send B-G-R [which means that received channel 3 is put out on

position 1, received channel 2 is put out on position 2, and received

channel 1 is put out on position 3.]

§ Example 2: If you set 4-1-2-3, received channel 4 is put our first. Received

channel 1 is put out second. Received channel 2 is put out third. Received

channel 3 is put out fourth.

§  Sets the value of the first port for all ports.

Channels Per Universe - Allows you to define how many DMX channels are

sent per DMX universe for each port. This option enables you to adjust the

device settings to the controller and LEDs you are using. Automatic - The

number of channels that is received is also sent out. This is the default value.

This is also the recommended setting when using NEBULA in combination with

the MADRIX 5 Software.

§ 1 - 512 - Limits the number of output channels to this value. If your

controller sends more channels than set up here, any channels that are

higher than this value will be discarded. If your controller sends fewer

channels, NEBULA will fill up the rest of the channels with values of 0

[Black].

§ Using RGB LEDs: 170 RGB LEDs can be controlled with one single DMX

universe. That means a maximum of 510 DMX channels is used.
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Depending on your controller [please see below], the recommended

setting is Automatic or 510.

§ Using RGBW LEDs: 128 RGBW LEDs can be controlled with one single DMX

universe. That means a maximum of 512 DMX channels is used.

Depending on your controller [please see below], the recommended

setting is Automatic or 512.

§ Using 1-channel LEDs: 512 single color LEDs can be controlled with one

single DMX universe. That means a maximum of 512 DMX channels is

used. Depending on your controller [please see below], the

recommended setting is Automatic or the number of LEDs used.

§ Using MADRIX 5: By default, MADRIX 5 sends optimized frames as set up

in the Device Manager. That means according to the number of channels

used by the fixtures and Patch, MADRIX 5 and then NEBULA will send out

the correct number of channels to the LEDs.

§ Using a 3rd-party controller: When your controller is only able to send full

frames [which means that it always sends 512 DMX channels per single

frame], it is recommended to set up a specific value here as described

above in order to correctly work with MADRIX NEBULA and your LEDs.

Recommendation: If using RGB LEDs, set up 510 channels per universe.

§  Sets the value of the first port for all ports.

Output Intensity - Sets the brightness level of the output towards the LEDs

by functioning as a dimmer.

§ For example, when the device receives a DMX value of 255 on a channel,

this would be dimmed to 127 when the Output Intensity is set to 50 %.

§ The minimum value is 1 %. The default value is 100 %.

§ Can be used alone or at the same time as Upper Intensity Limit. First, the

device applies the Output Intensity. Second, the Upper Intensity Limit is

applied.

Upper Intensity Limit - Sets the maximum brightness level that can be sent. 

§ The minimum value is 1 %. The default value is 100 %.

§ Can be used alone or at the same time as Output Intensity. First, the

device applies the Output Intensity. Second, the Upper Intensity Limit is

applied.
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In Case Of Missing Network Data - Allows you to specify the output settings

should the device not receive data for a specified DMX universe [in both cases,

when having never received data in the first place or when the data is not

being received anymore and a timeout is reached]. Choose from the following

options:

§ Send The Last Received Frame Continually

[Is true when data is not being received anymore and a timeout is

reached.]

[If no data is received at startup, black frames will be sent.]

§ Send Black Frames Continually

[Is true when data is not being received anymore and a timeout is

reached.]

[If no data is received at startup, black frames with value 0 will be sent.]

§ Send White Frames Continually

[Is true when data is not being received anymore and a timeout is

reached.]

[If no data is received at startup, white frames with value 255 will be

sent.]

§ Stop Sending After Sending A Black Frame

[Is true when data is not being received anymore and a timeout is

reached.]

[If no data is received at startup, black frames will be sent.]

§ Stop Sending

[Is true when data is not being received anymore and a timeout is

reached.]

[If no data is received at startup, there is also no output.]

Special Commands Reboot - Reboot System - Restarts the device completely. [The website will

automatically be reloaded after a few seconds.]

Reset - Reset To Factory Default Settings - Restores the original settings of

the device. [Since this may change back the IP address to the original setting,

the website will automatically be reloaded after a few seconds and you will

automatically be redirected to the correct website and IP address.]

Device Information § This section displays various details about the device, including:
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§ Model 

[The device type.]

§ IP Address 

[The current IP address. Can be used as a click-able link to call the device

with this IP address.]

§ NetBIOS 

[An alternate way to call up the web configuration or find the device in

the network, and without using the IP address. Can also be used as a

click-able link to call the device with its NetBIOS name. Main workflow:

Assuming correct network settings, simply type http://SERIALNUMBER/

into your web browser, such as http://NEBULA000085/ ; often merely

NEBULA000085/ should work. If you want to ping the device, use only

NEBULA000085]

§ MAC Address 

[A permanent, unique address.]

§ Serial Number

§ Firmware 

[The current firmware version.]

§ Bootloader 

[The current bootloader version.]

§ Hardware 

[The hardware revision.]

§ External Voltages 

[The current voltages for External Power, Port 1 (V+), and Port 2 (V+).]

§ System Temperature

[The current ambient temperature inside the device case.]

§ Ethernet 

[The current status of the two Ethernet ports.]

§ Up Time 

[The time that has passed since the last power-cycle or restart.]

Please Note Regarding LEDs That Need Be Addressed First

Certain LEDs need to addressed first. Please check the below table to see if your LEDs might need to be

addressed. 

§ If they are already addressed with another tool, you do not need to address them again.
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§ If your LEDs are not yet addressed, please address them: 

1. Connect your LEDs. Learn more »Putting The Device Into Operation 

2. Connect to power and data. Learn more »Putting The Device Into Operation 

3. Choose the corresponding Addressing Protocol as Output Protocol of the MADRIX NEBULA. Confirm

with 'Set'. You only have to do this once for your each LED tape.

4. Once your LEDs are addressed, continue by selecting the correct Output Protocol according to your

LEDs.

LED Addressing Protocol

§ WS2821 § Choose the Addressing Protocol 'WS2821 Addressing' in order to address your

LEDs.

§ WS2822S § Choose the Addressing Protocol 'WS2822S Addressing' in order to address your

LEDs.

2.2 MADRIX HARDWARE MANAGER [USB / Ethernet]

This topic includes:

§ Overview

§ Device Configuration

§ Firmware Updates

§ More Information

Overview

MADRIX HARDWARE MANAGER is a software tool that is available separately and allows you to manage

MADRIX hardware products.

It can be used for basic device configuration and to update the firmware of your device.

Download from »www.madrix.com

https://www.madrix.com/
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Important Information

§ Either use USB or the Ethernet connection!

- When using both connection types devices will be shown with two different entries in the list,

which may lead to severe issues when accidentally updating the device over both connections

simultaneously.

§ Make sure to -stop- sending control data to your devices when managing them with MADRIX

HARDWARE MANAGER.

- This refers to input and/or output over Art-Net, sACN, DMX512, etc.

- Otherwise, changes and updates might fail. If an update fails, stop sending data and try to

update the firmware again.
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Device Configuration

Basic Configuration

§ 1] In MADRIX HARDWARE MANAGER, navigate to the Devices tab.

§ 2] You will see connected devices in a list including their current main settings.

§ 3] Basic settings can be changed and configured, including Name, IP Address, Network Mask,

Gateway, and more.

Open Web Configuration

§ 1] In MADRIX HARDWARE MANAGER, navigate to the Devices tab and select a device/devices in the

list.

§ 2] Right Mouse Click > Open Device Configuration Via HTTP... opens your standard web browser

and the built-in web configuration of the selected device.

§ Learn more »Web Configuration [Ethernet]

Restore Factory Default Settings

§ 1] In MADRIX HARDWARE MANAGER, navigate to the Devices tab and select a device/devices in the

list.

§ 2] Right Mouse Click > Restore Factory Default Settings restores the original settings of the device.

[Since this may change back the IP address to the original setting, the website will automatically be

reloaded after a few seconds and you will automatically be redirected to the correct website and IP

address.]

Firmware Updates

§ 1] In MADRIX HARDWARE MANAGER, navigate to the Firmware Files tab and make sure you have

the right [the latest] firmware version already downloaded and available. An active internet

connection is required.

§ 2] Go to the tab Devices and select a device/devices in the list.



[Part 2] Device Configuration

//33www.madrix.com

MADRIX NEBULA User Manual

§ 3] Navigate to the column Firmware and select the firmware you wish to install on the devices.

More Information

Please see the MADRIX HARDWARE MANAGER User Manual for more information. 

See »help.madrix.com

http://help.madrix.com/
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3 Using MADRIX 5 Software

This topic includes:

§ Overview

§ MADRIX 5 Software License

§ Operating Modes

Overview

The MADRIX NEBULA works great in combination with the MADRIX 5 Software.

MADRIX 5 Software License

§ The MADRIX 5 Software license is not included and sold separately. A MADRIX 5 KEY is necessary if you

want to use output.

Operating Modes

You can use 3 operating modes together with the MADRIX 5 Software:

§ Data Output Over Ethernet Network [Art-Net] 

§ Data Output Over Ethernet Network [Streaming ACN / sACN] 

§ Data Output Over USB

3.1 Output [Art-Net]

This topic includes:

§ Data Output Over Ethernet Network [Art-Net]

§ 1] Initial Configuration
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§ 2] Windows Network Settings

§ 3] Fixture Patching In MADRIX 5

§ 4] Activating Art-Net

§ 5] Adding Devices Automatically

§ 6] Activating Devices

§ 7] Configuration Of DMX Output

§ 8] Frame Time

§ 9] Optimized Frames Or Full Frames

§ 10] Sync Mode

§ Additional Art-Net Device Settings

Data Output Over Ethernet Network [Art-Net]

You can connect the NEBULA over Ethernet network to the network card of your computer that runs the

MADRIX 5 Software. Data is distributed to the device over network cabling [Ethernet] and sent to the

output ports [Port 1 and Port 2].

1] Initial Configuration

§ Put MADRIX NEBULA into operation by connecting the LEDs, supplying power, setting the output

protocol, and setting the network data sources as described above. Learn more »Putting The Device

Into Operation 

§ Connect MADRIX NEBULA to your computer using Ethernet network cabling.

§ It is highly recommended to use Gigabit Ethernet network components [network card, switches, etc.].

§ Set up the corresponding settings in the »Configuration Using A Web Browser

2] Windows Network Settings

Art-Net is a network-based protocol. MADRIX 5 will use the network card of your computer to send data. 
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§ It is required to set up the correct network settings in Windows, first.

§ You must use these IP address and Subnet mask settings. Otherwise, Art-Net might not work!

§ The IP addresses of your computer and your MADRIX NEBULA devices need to be different.

§ Set up an individual IP address in the following IP address range:

- 2.0.0.1 ... 2.255.255.254 or

- 10.0.0.1 ... 10.255.255.254

§ Set up the corresponding Subnet mask

- 255.0.0.0

[Via factory default settings, MADRIX NEBULA devices will have an IP address in the 10.x.x.x

network range, such as 10.77.64.86, for example].

[Please note: Your devices and the sender, such as the PC that runs MADRIX 5, need to have the

same subnet mask!]

§ Restart MADRIX 5, if you have changed the network settings in Windows while MADRIX 5 was

running.

§ Learn more »Tips [Microsoft Windows / Networks / USB] 

§ Example for PCs that are running MADRIX 5:
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3] Fixture Patching In MADRIX 5

§ Start MADRIX 5.

§ Configure the virtual LED matrix using the Matrix Generator or Patch Editor.

4] Activating Art-Net

§ Go to the menu Preferences > Device Manager... > Art-Net 

[Keyboard shortcut: F4 > Art-Net]

§ Activate the checkbox Enable [in the upper, right corner].
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5] Adding Devices Automatically

MADRIX 5 can automatically add your MADRIX NEBULA devices.

§ Click 

[MADRIX 5 will automatically search the network for connected devices. Devices that are found will

appear in the list. Eight entries will be created in the list for each NEBULA device, one for each

universe.]

6] Activating Devices

Each of your MADRIX NEBULA devices and its ports need to be activated. By default, they are still

deactivated.
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§ Go to the menu Preferences > Device Manager... > DMX Devices 

[Keyboard shortcut: F4]

§ Select your devices and their ports in the list. 8 output universes will be shown.

§ Right Mouse Click on the column State to set from Off to On [indicated by green light.]
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§ [In the screenshot above, one NEBULA is connected. If more devices are connected, please use the

different IP addresses of different devices and device details [i] to identify them in the Device

Manager.]

7] Configuration Of DMX Output

§ Make sure that your output port is still selected under Preferences > Device Manager... > DMX

Devices

§ When using your device as an output device, set up Universe

- Right Mouse Click or Left Mouse Double-Click on the column Universe and enter the required

number.

§ This setting assigns a specific DMX universe [of the Patch] to the device or the port of the device.

§ Make sure to assign the correct universe according to your requirements.

Learn more »Glossary

§ By default, DMX universe 1 - 8 are assigned when using one MADRIX NEBULA.

NEBULA Output Universe Device Manager... > DMX Devices > Device
Name

DMX 1 BindIdx1 Port:0

DMX 2 BindIdx2 Port:0

DMX 3 BindIdx3 Port:0

DMX 4 BindIdx4 Port:0

DMX 5 BindIdx5 Port:0

DMX 6 BindIdx6 Port:0

DMX 7 BindIdx7 Port:0

DMX 8 BindIdx8 Port:0
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8] Frame Time

§ Make sure that your device is still selected under Preferences > Device Manager... > DMX Devices

§ Set up the frame time for your device.

- Right Mouse Click or Left Mouse Double-Click on the column ms / FPS and enter the required

number.

- The frame time [in milliseconds; ms] affects the frame rate. The frame rate specifies how fast data is

sent to the device or received from it [in Frames Per Second; FPS].

- Increase the frame time in order to decrease the frame rate [e.g., 40 ms = 25 FPS].

- Decrease the frame time in order to increase the frame rate [e.g., 20 ms = 50 FPS].

- The default value is 30 ms / 33.3 FPS.

- The minimum value is 1000 ms / 1 FPS. 

- The maximum value is 5 ms / 200 FPS. 

   Please note: If you want to output high frame rates, make sure to set Main Mixing FPS in the

Options to the same value in order to render the same frame rate [It is set to 50 FPS by default.

Otherwise, frames will be duplicated].

   Please note: If you want to input high frame rates, make sure to set DMX Controller Input FPS in the

Options to the same value in order to process the same frame rate [It is set to 50 FPS by default.

Otherwise, frames will be duplicated].

- Some LED fixtures might have problems with a low frame time / high frame rate. Then, it is

recommended to increase the frame time / decrease the frame rate.

§ [When using Art-Net, the Frame Time [ms] can be individually set for each port. But it cannot be set

individually for each port, when Sync Mode is activated. Learn more below.]

9] Optimized Frames Or Full Frames

§ Make sure that your device is still selected under Preferences > Device Manager... > DMX Devices

§ Choose how to send data.

- Right Mouse Click or Left Mouse Double-Click on the column Frames to choose between

Optimized and Full

- Per DMX512 standard, MADRIX 5 only sends the number of DMX channels that is configured

[optimized frames]. For example, if you are using 312 DMX channels on a DMX universe, only 312 DMX

channels will be sent with every single frame on this universe.
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- Activate Full Frames if devices should always send full frames on a particular universe, instead of

optimized frames. Sending full frames means that always the full 512 DMX channels of a DMX universe

will be sent with every frame [even when you are using less than 512 channels on the universe].

- Activating Full Frames is recommended if problems with the data output of your devices occur.

§ In addition, you can activate Full Frames for the device and each MADRIX NEBULA output universe

separately.

10] Sync Mode

MADRIX NEBULA can use the special sync mode of Art-Net. 

§ Large LED projects require dependable data distribution. The MADRIX 5 Software and NEBULA

hardware allow you to fully synchronize data output for all output DMX ports and even across multiple

NEBULA devices to get an optimal image on the LEDs.

§ When Art-Net sync mode is activated, MADRIX 5 and MADRIX NEBULA will automatically handle the

synchronization of data.

Art-Net Sync Mode is highly recommended for MADRIX NEBULA!

ArtSync - Allows you to activate or deactivate the usage of synchronization

commands/packages for Art-Net. 

- Your Art-Net devices need to support this feature in order for it to work

correctly.

- All MADRIX hardware Art-Net nodes support ArtSync.

- Sync packages will be sent to all network cards for which corresponding Art-

Net nodes are created in the MADRIX 5 Software.

In addition, you can choose between Post-Sync [default] and Pre-Sync. By

default, the sync data is sent after the main DMX/Art-Net data. Pre-Sync would

send it before the main DMX/Art-Net data.

§ Before activating sync, make sure that all activated Art-Net devices are

available in your network! Else, the frame rate of Art-Net might drop. If

you are not sure, do not enable any sync mode.
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§ Disable ArtSync if you wish to HTP merge from two sources! ArtSync

would then interfere with the merge and create unwanted results.

Additional Art-Net Device Settings

It is very important to set up the correct settings of your devices!

Broadcast Mode Or Unicast Mode

MADRIX 5 can send Art-Net data in 2 ways to your Art-Net devices:

§ Broadcast Mode - Means that every packet sent from a single transmitter will be received by all

recipients in the network. MADRIX 5 will send data to all devices in the network.

- Advantage: The same data [e.g., DMX universe 1 and 2] can be made available at different points of

your setup.

- Disadvantage: A potentially huge number of data packages will be sent over the network. This can

reduce the overall network performance and cause data issues or instability.

§ Unicast Mode - Means that the specific data will only be sent to the specified recipient.

- Advantage: Data traffic is reduced immensely, which means that a larger number of Art-Net devices

can be used in one network. Reduced network traffic increases the performance and stability.

- Disadvantage: The network settings of all devices need to be 100% correct.

Unicast Mode is recommended in general.

§ Go to the menu Preferences > Device Manager... > Art-Net 

[Keyboard shortcut: F4 > Art-Net]

§ Select your device in the list.

§ Click 

§ A new window will open.
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§ A] Choose Send Unicast Mode to activate unicast mode:

- Make sure to enter the correct IP Address of your device that should receive the Art-Net data.

- MADRIX 5 will send the corresponding data only to this device.

§ B] Choose Send Broadcast Mode to activate Broadcast Mode:

- Make sure to select the correct Network card of your computer that should send the Art-Net data.

- MADRIX 5 will send data to the whole Art-Net network.

§ Click Apply

Status Indicators [ArtAddress]

In order to use these features, Enable ArtAddress first.

§ Regarding sending ArtAddress commands to nodes, make sure that your nodes fully support this Art-

Net feature.

You will also get notified by a message box. Confirm the message with OK or abort via Cancel

§ MADRIX LUNA, MADRIX NEBULA, MADRIX PLEXUS, MADRIX STELLA, MADRIX ORION, and MADRIX AURA

support ArtAddress.

§ MADRIX 5 itself can receive ArtAddress commands.

Mute Status Indicators - Switches off and disables all built-in status indicators

of a device over Art-Net [ArtAddress > AcLedMute].

Operate Status Indicators Normally - Allows the built-in status indicators of

a device to operate normally again, after having them switched off [ArtAddress

> AcLedNormal].

Highlight Device - Activates the highlight mode [ArtAddress > AcLedLocate].

Select one or more interfaces and click the button. The corresponding status

indicators of the selected interfaces will flash for a better identification or tests.

This makes it easier to see them on site/stage. It considerably speeds up the

procedure of programming or testing the selected interfaces. 

In addition to sending out commands to nodes, MADRIX 5 itself can receive

ArtAddress commands.
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Receive - Activates that MADRIX 5 is able to receive ArtAddress commands. It

is enabled by default.

§ AcLedMute and AcLedNormal will disable the identification of MADRIX 5.

§ AcLedLocate will enable the identification of MADRIX 5.

- As long as Identify is enabled or set via protocol commands, the MADRIX

5 user interface [GUI] will repeatedly change every second from the

currently selected theme to the opposite theme, either from dark to light

or vice versa. 

- This visibly highlights the user interface for visual identification of this

MADRIX 5 instance as a device within a network system.

- Identify will also be deactivated when manually switching the theme,

either via the menu [View > Theme > Light/Dark] or its keyboard

shortcut [Ctrl+T].

You can further customize ArtAddress properties under menu Preferences >

Options... > General

3.2 Output [sACN]

This topic includes:

§ Data Output Over Ethernet Network [Streaming ACN / sACN]

§ 1] Initial Configuration

§ 2] Windows Network Settings

§ 3] Fixture Patching In MADRIX 5

§ 4] Activating Streaming ACN

§ 5] Activating Devices

§ 6A] Configuration Of Single Devices

§ 6B] Configuration Of Multiple Devices

§ 7] Frame Time

§ 8] Optimized Frames Or Full Frames
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Data Output Over Ethernet Network [Streaming ACN /

sACN]

You can connect the NEBULA over Ethernet network to the network card of your computer that runs the

MADRIX 5 Software. Data is distributed to the device over network cabling [Ethernet] and sent to the

output ports [Port 1 and Port 2].

1] Initial Configuration

§ Put MADRIX NEBULA into operation by connecting the LEDs, supplying power, setting the output

protocol, and setting the network data sources as described above. Learn more »Putting The Device

Into Operation 

§ Connect MADRIX NEBULA to your computer using Ethernet network cabling.

§ It is highly recommended to use Gigabit Ethernet network components [network card, switches, etc.].

§ Set up the corresponding settings in the »Configuration Using A Web Browser

2] Windows Network Settings

§ MADRIX 5 automatically sets up Streaming ACN network settings for you.

[MADRIX 5 supports multicast Streaming ACN. Data is automatically sent to all corresponding sACN

devices in the network. Unicast is also supported.] 

§ You only need a computer with a network card and a valid IP address.

§ You do not have to change the IP address settings in Windows for Streaming ACN!

§ The IP address range for sACN devices is 239.255.X.X according to the Streaming ACN

specifications. MADRIX NEBULA automatically works this way.

§ Make sure that your Firewall does not block data of the 239.255.X.X IP address range!

§ Check the settings of the Windows Firewall. 

§ Learn more »Tips [Microsoft Windows / Networks / USB] 
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3] Fixture Patching In MADRIX 5

§ Start MADRIX 5.

§ Configure the virtual LED matrix using the Matrix Generator or Patch Editor.

4] Activating Streaming ACN

§ Go to the menu Preferences > Options... > Devices Network

[Keyboard shortcut: Ctrl+Alt+O > Devices Network]

§ Activate ESTA - Streaming ACN

§ Choose your network card from the drop-down list. Make sure to select the correct network adapter

that will be used for Streaming ACN!

[The IP address and Subnet mask label should help you select the correct adapter. It is not necessary

to change any of these networks settings.]

§ ACN Device Count - Set up how many you are going to use. MADRIX NEBULA requires 8 sACN devices

per unit.

[This is the total amount of devices. Please set the exact number of devices you are using. If the count

is higher, this creates unnecessary network traffic.]

§ Click Apply



[Part 3] Using MADRIX 5 Software

//49www.madrix.com

MADRIX NEBULA User Manual

§ ACN CID - Being a network protocol, Streaming ACN sends a so-called CIDs [Component Identifier].

- Every single ACN device has such a unique ID.

- When using Streaming ACN, your MADRIX 5 Software is one of those devices.

- When you start MADRIX 5 for the first time, this ID will be generated automatically for you. From this

point onwards it will be used on your PC.

- With this ID your MADRIX 5 Software can be easily identified in the network. Interfaces can detect

this unique ID and can be configured to receive data from this particular device. Please note that the

ACN interface must support this feature.

- Do not change the ACN CID, unless you are an experienced user!

§ Click OK to close the window.

5] Activating Devices

Each of the ports need to be activated if that is not already the case.
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§ Go to the menu Preferences > Device Manager... > DMX Devices 

[Keyboard shortcut: F4]

§ Select your devices and their ports in the list. 8 output universes will be shown.

§ Right Mouse Click on the column State to set from Off to On [indicated by green light]. By default, the

devices are already activated.

§ [In the screenshot above, one NEBULA is connected. If more devices are connected, please use the

different universes of different devices to identify them in the Device Manager.]

§ Universe - Defines which universe of your MADRIX 5 Patch is sent to this particular device.

- Right Mouse Click on the column Universe in order to enter a different number.

6A] Configuration Of Single Devices

§ Select a device in the list and click 
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§ A new window will open.

Set up the following settings for your devices:

§ Source Name -  Allows you to set up a specific name for the device. This name is send via network as

well. Therefore, interfaces may be able to retrieve this name and can be configured to receive data

from this source.

- If you are using the default name MADRIX U:X, the universe will automatically be displayed in the

name [represented by X: 1, 2, 3, etc.].
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§ ACN Universe - Defines the DMX universe of the device. 

- Set up the same universe that is set up in your sACN device, which is MADRIX NEBULA.

- According to the Streaming ACN specifications, MADRIX 5 will automatically change the ACN IP

Address according to the ACN Universe.

§ ACN Priority - Was implemented for backup solutions. Valid values range from 0 to 200, which is the

highest priority.

- For example, you may have set up two MADRIX PCs. One gets a priority of 100. The second PC gets

a priority of 50. If the first PC fails and only if it malfunctions, data will be automatically received from

PC #2.

- Data will always be received from the device with the highest priority. Please note that the ACN

device must support this feature.

§ ACN Protocol - Automatically selects the ANSI 2009 standard.

§ Use Multicast

ACN Multicast IP Address - Displays the IP address of the device as automatically assigned by

MADRIX 5 according to the Streaming ACN specifications. The last 2 digits match the assigned DMX

universe.

§ Use Unicast

ACN Unicast IP Address - Uses a specific IP address to send data to.

§ Click Apply to confirm your changes.

§ Click OK to close the window.

6B] Configuration Of Multiple Devices

§ You can configure several interfaces at the same time.

§ Follow the steps of 6A, but select multiple devices and click 

§ A new window will open.
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§ Set up the settings as described under 6A].

§ For ACN Universe, you have now additional options for Numbering:

Click the button and MADRIX 5 will automatically increase the ACN Universe number for all

the selected devices [which can be seen in the DMX Devices tab of the Device Manager], starting with

the value you have entered.

§ Click Apply and OK to confirm your changes.

7] Frame Time

§ Make sure that your device is still selected under Preferences > Device Manager... > DMX Devices

§ Set up the frame time for your device.

- Right Mouse Click or Left Mouse Double-Click on the column ms / FPS and enter the required

number.

- The frame time [in milliseconds; ms] affects the frame rate. The frame rate specifies how fast data is

sent to the device or received from it [in Frames Per Second; FPS].

- Increase the frame time in order to decrease the frame rate [e.g., 40 ms = 25 FPS].

- Decrease the frame time in order to increase the frame rate [e.g., 20 ms = 50 FPS].

- The default value is 30 ms / 33.3 FPS.

- The minimum value is 1000 ms / 1 FPS. 

- The maximum value is 5 ms / 200 FPS. 
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   Please note: If you want to output high frame rates, make sure to set Main Mixing FPS in the

Options to the same value in order to render the same frame rate [It is set to 50 FPS by default.

Otherwise, frames will be duplicated].

   Please note: If you want to input high frame rates, make sure to set DMX Controller Input FPS in the

Options to the same value in order to process the same frame rate [It is set to 50 FPS by default.

Otherwise, frames will be duplicated].

- Some LED fixtures might have problems with a low frame time / high frame rate. Then, it is

recommended to increase the frame time / decrease the frame rate.

8] Optimized Frames Or Full Frames

§ Make sure that your device is still selected under Preferences > Device Manager... > DMX Devices

§ Choose how to send data.

- Right Mouse Click or Left Mouse Double-Click on the column Frames to choose between

Optimized and Full

- Per DMX512 standard, MADRIX 5 only sends the number of DMX channels that is configured

[optimized frames]. For example, if you are using 312 DMX channels on a DMX universe, only 312 DMX

channels will be sent with every single frame on this universe.

- Activate Full Frames if devices should always send full frames on a particular universe, instead of

optimized frames. Sending full frames means that always the full 512 DMX channels of a DMX universe

will be sent with every frame [even when you are using less than 512 channels on the universe].

- Activating Full Frames is recommended if problems with the data output of your devices occur.

§ In addition, you can activate Full Frames for the device and each MADRIX NEBULA output universe

separately.

3.3 Output [USB]

This topic includes:

§ Data Output Over USB

§ 1] Initial Configuration

§ 2] Fixture Patching In MADRIX 5

§ 3] Enabling Drivers

§ 4] Activating Devices

§ 5] Configuration Of DMX Output

§ 6] Frame Time

§ 7] Optimized Frames Or Full Frames
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Data Output Over USB

You can connect the NEBULA directly via USB to the computer that runs the MADRIX 5 Software. Data is

distributed to the MADRIX NEBULA over USB and sent to the two output ports [Port 1 and Port 2].

1] Initial Configuration

§ Put MADRIX NEBULA into operation by connecting the LEDs, supplying power, and setting the output

protocol as described above. Learn more »Putting The Device Into Operation 

§ Connect MADRIX NEBULA to your computer via USB.

[Use the provided USB cable.]

§ Make sure to check the power-management options of Windows. Learn more »PC Power

Management

2] Fixture Patching In MADRIX 5

§ Start MADRIX 5.

§ Configure the virtual LED matrix using the Matrix Generator or Patch Editor.

3] Enabling Drivers

§ Go to the menu Preferences > Options... > Devices USB 

[Keyboard shortcut: Ctrl+Alt+O > Devices USB]
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§ Activate MADRIX NEBULA

[The option is activated by default.]

§ Click Apply

§ Close the window with OK

4] Activating Devices

§ Go to the menu Preferences > Device Manager... > DMX Devices 

[Keyboard shortcut: F4]

§ Your NEBULA devices and all of their output universes will appear in the list.

§ If your devices are not in the list, click 

[In the screenshot below, one NEBULA is connected.]

§ By default, all output ports are activated [State On].
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§ If your device and ports are not activated, do the following:

§ Select the device/port in the list.

§ Right Mouse Click on the column State to set from Off to On [indicated by green light].

5] Configuration Of DMX Output

§ Make sure that your output port is still selected under Preferences > Device Manager... > DMX

Devices

§ When using your device as an output device, set up Universe

- Right Mouse Click or Left Mouse Double-Click on the column Universe and enter the required

number.

§ This setting assigns a specific DMX universe [of the Patch] to the device or the port of the device.

§ Make sure to assign the correct universe according to your requirements.

Learn more »Glossary
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6] Frame Time

§ Make sure that your output port is still selected under Preferences > Device Manager... > DMX

Devices

§ Set up the frame time for your device.

- Right Mouse Click or Left Mouse Double-Click on the column ms / FPS and enter the required

number.

- The frame time [in milliseconds; ms] affects the frame rate. The frame rate specifies how fast data is

sent to the device or received from it [in Frames Per Second; FPS].

- Increase the frame time in order to decrease the frame rate [e.g., 40 ms = 25 FPS].

- Decrease the frame time in order to increase the frame rate [e.g., 20 ms = 50 FPS].

- The default value is 30 ms / 33.3 FPS.

- The minimum value is 1000 ms / 1 FPS. 

- The maximum value is 5 ms / 200 FPS. 

   Please note: If you want to output high frame rates, make sure to set Main Mixing FPS in the

Options to the same value in order to render the same frame rate [It is set to 50 FPS by default.

Otherwise, frames will be duplicated].

   Please note: If you want to input high frame rates, make sure to set DMX Controller Input FPS in the

Options to the same value in order to process the same frame rate [It is set to 50 FPS by default.

Otherwise, frames will be duplicated].

- Some LED fixtures might have problems with a low frame time / high frame rate. Then, it is

recommended to increase the frame time / decrease the frame rate.

§ [When using USB, the frame time will be automatically set to the same value for all output ports.]

7] Optimized Frames Or Full Frames

§ Make sure that your device is still selected under Preferences > Device Manager... > DMX Devices

§ Choose how to send data.

- Right Mouse Click or Left Mouse Double-Click on the column Frames to choose between

Optimized and Full

- Per DMX512 standard, MADRIX 5 only sends the number of DMX channels that is configured

[optimized frames]. For example, if you are using 312 DMX channels on a DMX universe, only 312 DMX

channels will be sent with every single frame on this universe.

- Activate Full Frames if devices should always send full frames on a particular universe, instead of

optimized frames. Sending full frames means that always the full 512 DMX channels of a DMX universe

will be sent with every frame [even when you are using less than 512 channels on the universe].
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- Activating Full Frames is recommended if problems with the data output of your devices occur.

§ In addition, you can activate Full Frames for the device and each MADRIX NEBULA output universe

separately.
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4 RDM And MADRIX RADAR

Topics Of This Chapter

§ Using RDM And MADRIX RADAR

4.1 Using RDM And MADRIX RADAR

This topic includes:

§ Overview

§ Settings

§ MADRIX RADAR

Overview

The MADRIX NEBULA supports RDM in the way that it can act as an RDM Responder.

This means that the device acts on commands and replies to requests with its own status and sensor data

via ArtRdm [RDM Responder].

Settings

Make sure that the ArtRdm is enabled in the settings of the device.

Learn more »Web Configuration [Ethernet] 

MADRIX RADAR
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Overview

You can use software like MADRIX RADAR to use and monitor the RDM functionality.

Parameters
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Sensors
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5 Technical Support

Topics Of This Chapter

§ Firmware Updates

§ Troubleshooting

5.1 Firmware Updates

This topic includes:

§ Overview

§ MADRIX HARDWARE MANAGER

§ Available Firmware Updates

Overview

It is highly recommended to update the firmware should a new firmware version become available. 

MADRIX HARDWARE MANAGER

To update your devices, please use the separate MADRIX HARDWARE MANAGER software.

Learn more »MADRIX HARDWARE MANAGER [USB / Ethernet] 

Available Firmware Updates

Sorted in descending order.

Latest Version Highlights
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NEBULA Firmware
6.05.0924

Release Date
December 2024

§ Added new supported LEDs: MBI6023 (#11413).

§ Added 16-bit support for the UCS7604 protocol (#11104).

§ Now provides the version of the bootloader over RDM (#10871).

§ Now provides the used network Gateway in a specific Art-Net reply
(#11038).

§ Fixed an issue that produced an incorrect timing for the MBI6120 protocol at
800 kHz (#10329).

§ Fixed an issue when setting the Device Name over RDM (#10836).

§ Fixed a critical issue that caused the device to stop working when selecting
the MBI6024 protocol (#11461).

§ Fixed a critical issue that caused the device to stop working when selecting
the MBI6120 protocol (#11461).

§ Fixed a critical issue that caused the device to stop working when selecting
the TLC5973 protocol (#11461).

§ Fixed an issue that caused the MBI6024 protocol not to work anymore when
using an Offset (#11498).

NEBULA Firmware
6.04.0889

Release Date
May 2024

§ Added new supported LEDs: UCS7604 (#10612).

§ Art-Net 4: Added Squawking to the PollReply for better device identification
in [software or hardware] controllers who support this feature (#10691).

§ UCS9812S: Improved calculations of the used frequency (#10432).

NEBULA Firmware
6.03.0862

Release Date
December 2023

§ Web Configuration: Improved the NetBIOS functionality by writing out the
full address for web browsers (#10355).

§ Improved discarding of ArtRdm draft packets by additionally checking the
ArtRdm version flag (#10363).

§ Fixed an issue with the 'Node Report' field of the Art-Net implementation
(#10370).

NEBULA Firmware
6.02.7429

§ Added new supported LEDs: FW1935 (#10331).

§ Added new supported LEDs: LB1908 (#10331).

§ Added new supported LEDs: TM1934 (#10331).

§ Added new supported LEDs: UCS2904B (#10331).

§ Added new supported LEDs: UCS5603A (#10331).

§ Added new supported LEDs: WS2811F (#10331).

§ Added new supported LEDs: WS2811M (#10162).

§ Added new supported LEDs: WS2814F (#10331).

§ Added new supported LEDs: WS2818M (#10282).

§ Web Configuration: Added NetBIOS functionality and information in the
Device Information section to find and connect to devices using the NetBIOS
name instead of the IP address (#10246).

NEBULA Firmware
6.01.7426

Release Date
September 2023

§ Added new supported LEDs: SM16704 (#9978).

§ Increased the intensity of the devices' status LEDs, especially of the red LED
(#10092).

§ Web Configuration: Fixed a typographic error regarding TLS3001 to
Quadratic (#9726).

§ Web Configuration: Checkmarks for checkboxes are now shown in the
correct green accent color (#9963).

§ Fixed an issue that did ignore the BindIndex via ArtAdress; resulting in users
only being able to set the first universe via ArtAddress (#10134).
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NEBULA Firmware
6.00.7423

Release Date
May 2023

§ Increased the maximum number of universes from 4 per port to 6 per port;
from 8 to 12 universes in total (#7449, #7909, #8034, #8552, #9399). 
Please refer to chapter Web Configuration [Ethernet] for more information
about the feature and recommendations.

NEBULA Firmware
5.02

§ Web Configuration: TLS3001 is available again separately as Linear and
Quadratic options; with optimized performance (#9656).

§ Fixed an issue that could halt the device when using protocol SM16716 in 3
or 6 universes configuration (#9642).

NEBULA Firmware
5.01.7419

Release Date
April 2023

§ Fixed an issue that did not respond to an Art-Net ArtTodControl request
regarding RDM (#9604).

NEBULA Firmware
5.00.7417

Release Date
April 2023

§ Added new supported LEDs: UCS8903 (#9119).

§ Added new supported LEDs: WS2812C (#8936, #9118).

§ Streamlined and freed up system resources (#7922, #8553).

Bootloader
5.00.7418

Release Date
April 2023

§ Bootloader 5.0: Is able to provide the MAC address of the device over USB
(#9389).

NEBULA Firmware
4.07.7413

Release Date
April 2023

§ Fixed an issue that did not correctly join and leave universe assignments in
case of sACN (#9575).

§ Fixed an issue that did not show an 'FPS' value for WS2803 (#9583).

§ Fixed an issue that the output frequencies functioned incorrectly for
TLC5973 (#9585).

§ Fixed an issue regarding the green channel of SK9816 that resulted in
incorrect white at full supply of power (#9595).

NEBULA Firmware
4.06.7408

Release Date
April 2023

§ Fixed an issue that uncontrolledly added zeros or possibly data to the HTML
source code of the web configuration via a Firmware's hash value (#9569).

NEBULA Firmware
4.05.7407

Release Date
January 2023

§ Added new supported LEDs: UCS5603 (#8897).

§ Added new supported LEDs: TM1803 (#9340).

§ Improved reliability by ensuring that network settings are always properly
saved (#9213).

§ Web Configuration: Added automation options to set the value of the first
port for all other ports as well as automatic numbering of the Assigned
Network Universes (#9291).

§ Web Configuration: Added the development hash to the firmware version to
the Device Information section (#9361).

NEBULA Firmware
4.04.7403

§ Added new supported LEDs: UCS2603 (#9189).

§ Fixed an issue that caused TM1829 to flicker when using an Offset of 1 and
setting at least one of every fourth channel to value 255 (#9074).
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NEBULA Firmware
4.03.7401

MADRIX Version
MADRIX 5.5c

Release Date
October 2022

§ Added new supported LEDs: WS2814 (#8970).

§ Fixed an issue that could degrade the performance of the device when using
WS2801 and high FPS due to a duplicate function call (#8938).

§ Fixed an issue that caused WS2801 to flicker in case of receiving frame times
that were too short (#8941).

NEBULA Firmware
4.02.7398

MADRIX Version
MADRIX 5.5b

Release Date
August 2022

§ The bootloader version can now be provided by the firmware over USB
(#8874).

§ Fixed an issue that showed the available frequencies of the TM1804 protocol
in an incorrect order (#8804).

§ Fixed an issue that ignored a positive Channel Offset for the APA101
protocol (#8830).

§ Fixed an issue that ignored a positive Channel Offset for the LPD6803
protocol (#8827).

§ Fixed an issue that ignored a positive Channel Offset for the LPD8806
protocol (#8828).

§ Fixed an issue that ignored the Channel Offset for the MBI6024 protocol
(#8837).

§ Fixed an issue that ignored a positive Channel Offset for the MBI6120
protocol (#8836).

§ Fixed an issue that ignored a positive Channel Offset for the SK9826
protocol (#8834).

§ Fixed an issue that ignored a positive Channel Offset for the SM16716
protocol (#8835).

§ Fixed a critical issue that would halt the device when using a Channel Offset
of -511 (#8839).

NEBULA Firmware
4.01.7397

Bootloader
4.01.9396

MADRIX Version
MADRIX 5.5a

Release Date
July 2022

§ Added new supported LEDs: VS17822 (#8526).

§ Added new supported LEDs: WS2821 (#8081).

§ Added WS2803 Reversed (#7456).

§ Web Configuration: Added Universe Count to define the number of enabled
universes per port (#7607).

§ Added support for new hardware components (#8029).

§ Bootloader 4.0: Fixed an issue that did not always respond to firmware
packets being sent over Art-Net (#8027).

§ Bootloader 4.0: Added support for new hardware components (#8028).

§ Bootloader 4.0: A single Art-Net PollReply is being sent after starting and
remaining in the bootloader (#8032).

§ Fixed an issue that caused WS2803 to reverse the direction (#7456).

§ Fixed an issue that caused WS2803 to stop working correctly when using a
Channel Offset (#7553).

§ Fixed an issue that caused WS2803 to stop working when receiving more
than 510 channels per universe (#7625).

§ Fixed an issue that only allowed to control 85 pixels when sending only 1
universe of optimized frames for GS8206, GS8207, GS8208, SK6813
(#8414).

§ Fixed an issue that caused MBI6024 to stop working (#8638).

§ Fixed an issue that caused MBI6120 to stop working (#8639).
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§ Fixed a number of issues with supported protocols, such as the missing
WS2803 Reversed 12 MHz and WS2803 Reversed 24 MHz options from
version 4.00 or incorrect labels (#8798).

NEBULA Firmware
3.03.7390

MADRIX Version
MADRIX 5.4h

Release Date
April 2022

§ Web Configuration: Added the possibility to edit the ShortName identifier for
Art-Net (#8159).

§ Web Configuration: Added option 'Send White Frames Continually' for the 'In
Case Of Missing Network Data' setting (#8169).

§ Web Configuration: Now shows the uptime of the device (#8183).

§ Fixed an issue on the web-configuration page that disabled ArtRdm again
after confirming changes in the SPI Output Configuration section with Set
(#8248).

NEBULA Firmware
3.02.7387

MADRIX Version
MADRIX 5.4g

Release Date
March 2022

§ Web Configuration: Now shows the output FPS that can be achieved with
the current settings (#8037).

§ Fixed that the WS2801 protocol did not send a break (#8052).

§ Fixed a minor issue with the LPD6803 protocol (#8095).

§ Fixed an issue that showed the available frequency of LPD1882S at 1.2 MHz
instead of the correct 1 MHz (#8098).

§ Fixed an issue that caused the TLC5973 protocol to sent with double the
speed of the set frequency (#8099).

§ Fixed an issue with the WS2811S protocol that sent with 400 kHz when 800
kHz was set and with 800 kHz when 400 kHz was set (#8119).

§ Fixed an issue that could produce incorrect results for the output when
using Channel Offset and Channels Per Universe in the web configuration at
the same time (#8128).

§ Fixed an issue that did not send an ArtTodData packet after enabling ArtRdm
in the web configuration (#8136).

NEBULA Firmware
3.01.7385

MADRIX Version
MADRIX 5.4f

Release Date
January 2022

§ Supported LEDs: APA104 [400 kHz] has been changed and renamed to
APA104 [585 kHz] (#7891).

§ Supported LEDs: APA106 [400 kHz] has been deprecated. Please use
APA106 [585 kHz], which is also automatically used after an update if
APA160 [400 kHz] was selected (#7870).

§ Supported LEDs: APA106 [800 kHz] has been changed and renamed to
APA106 [585 kHz] (#7870).

§ Web Configuration: ArtRdm is now supported. [NEBULA acts on commands
and replies to requests with its own status and sensor data as RDM
Responder.] (#7131).

§ Supports the RDM flag to the latest Art-Net 4 protocol revision 1.4dd2
(#7904).

§ The bootloader can now read the hardware revision/model over USB
(#7802).

§ Fixed a critical issue that could cause the bootloader on hardware revision
1.2 to freeze at startup with the status-LED Power being permanently on
(#7808).

§ Fixed a critical issue for WS2811 that could cause random flickering on the
LEDs (#7850).

§ Fixed an issue that caused network delays in daisy-chain mode when
receiving broadcast data and having enabled WS2811 (#7851).

§ Fixed a critical issue that would freeze the device when switching from sACN
to Art-Net as data source while receiving sACN data on all universes as well
as merged data from two Art-Net sources on all universes (#7869).
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NEBULA Firmware
3.00.7380

MADRIX Version
MADRIX 5.4e

Release Date
October 2021

§ Updated the system of the device (#6971, #7115, #7117, #7504).

§ Updated the bootloader of the device (#7544).

§ A single bootloader now supports both Ethernet ports (#7695).

§ Fixed an issue for WS2811 that caused flickering on the second port;
especially when using a different protocol on the first port (#2785).

§ Fixed an issue that may cause flickering of the first LED or produced
unexpected results when using custom values for Channel Offset and
Channel Order and thus both functions at the same time (#7581).

§ Fixed an issue for GS8207 that might cause flickering of the first LED when
using a channel offset by only outputting channel counts that can be divided
by 3 (#7599). 

§ Fixed an issue that did not initiate an ArtPollReply when changing the IP
address using the web configuration page (#7668).

§ Fixed an issue that did not consistently initiate a PollReply when changing
settings using the web configuration page (#7689).

NEBULA Firmware
2.06.7355

MADRIX Version
MADRIX 5.4c

Release Date
July 2021

§ Added new supported LEDs: GS8206 (#6924).

§ Added new supported LEDs: MBI6024 (#6927).

§ Added new supported LEDs: SK6112 (#6919).

§ Added new supported LEDs: SK6805 (#6926).

§ Added new supported LEDs: SK6813 (#6922).

§ Added new supported LEDs: SK9816 (#6921).

§ Added new supported LEDs: SK9822 (#6918).

§ Added new supported LEDs: SK9826 (#6923).

§ Added new supported LEDs: TLC5973 (#7253).

§ Added new supported LEDs: UCS2904 (#6925).

§ Web Configuration: Added the option to set the Output Intensity (#7317).

§ Web Configuration: Added the option to set the Upper Intensity Limit
(#7317).

§ Web Configuration: Added the option to reboot the device (#7403).

§ Web Configuration: Added the option to reset the device to factory default
settings (#7403).

§ Fixed an issue that could prevent changed settings from being saved in rare
cases after a power cycle (#5382).

§ Fixed an issue that did not show the favicon in web browsers (#6460).

§ Fixed that the option Send The Last Received Frame Continually did not
work correctly when a universe failed after having received several
universes of data (#7344).

§ Fixed a critical issue that could halt the device when changing the LED
protocol in rare cases (#7413).

§ Fixed an issue that could cause frame dropouts when sending with very high
frame rates, receiving data from multiple sources, and dimming the output all
at the same time (#7452).

NEBULA Firmware
2.05.7308

MADRIX Version
MADRIX 5.4b

Release Date
May 2021

-
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NEBULA Firmware
2.04.7304

MADRIX Version
MADRIX 5.4a

Release Date
February 2021

§ Fixed a critical issue that could halt the device when receiving an Art-Net
OpIpProg request (#6852).

§ Fixed an issue that did not save the chosen value for the 'In Case Of
Network Data Timeout' setting for the second port (#6899).

NEBULA Firmware
2.03.7291

MADRIX Version
MADRIX 5.4

Release Date
December 2020

§ Added new supported LEDs: GS8208.

§ Added new supported LEDs: MY9291.

§ Fixed minor issues.

NEBULA Firmware
2.03.7261

MADRIX Version
MADRIX 5.3

Release Date
May 2020

§ Fixed an issue that could freeze the device if RDM packages were still sent
to the device, although it communicated that it does not support RDM.

NEBULA Firmware
2.03.7259

MADRIX Version
MADRIX 5.2

Release Date
November 2019

§ Channel Order 4-1-2-3 has been added.

NEBULA Firmware
2.03.7252

MADRIX Version
MADRIX 5.1a

Release Date
August 2019

-

NEBULA Firmware
2.03.7236

MADRIX Version
MADRIX 5.1

Release Date
June 2019

§ Start Channel has been redesigned to Channel Offset.

§ Changed task ratio of SM16703 from 1:2/2:1 to 1:3/3:1.

§ Fixed an issue that only applied a new IP address that was set over USB
after a power cycle. 

§ Fixed an issue that did continue to send the last frame that was received
over USB under certain circumstances although new network data was
received.

§ Fixed an issue that could freeze the device, when quitting the MADRIX 5
Software while using LPD6803 and having Channels Per Universe set to a
value that could not be divided by 3.

§ Fixed an issue that did not allow receiving data over USB when merging
data from Art-Net and sACN.

§ Fixed an issue that allowed special characters and control characters [ASCII]
in names and descriptions, which are not filtered out.
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NEBULA Firmware
2.02.7206

MADRIX Version
MADRIX 5.0e

Release Date
February 2019

§ Added new supported LEDs: GS8207.

§ Added new supported LEDs: TM1804 [400 kHz].

§ Added new supported LEDs: UCS2903.

§ Web Configuration: Universes up to number 32,768 can now be assigned.

§ During normal operation, pressing the Reset button now sends an Art-Net
PollReply [e.g., Device Manager] and a MADRIX PollReply [MADRIX Device
Configuration].

§ Changed the Art-Net PollReply to assign a separate BindIdx to each
universe.

§ Fixed an issue for SJ1221 that could lead to flickering when using very long
tape.

§ Fixed an issue that did only apply a new IP address after changing it over
USB after disconnecting it from power first.

NEBULA Firmware
2.01.7147

MADRIX Version
MADRIX 5.0d

Release Date
August 2018

§ Fixed an issue for TM1814 that did not correctly control the current.

§ Fixed an issue that did not activate Streaming ACN without a power
disconnect when switching from Art-Net while data was received.

§ Fixed an issue that did not refresh the web configuration page correctly
when switching from sACN to Art-Net and confirming with Set. 

§ Fixed a critical issue that could halt the device in rare cases.

NEBULA Firmware
2.00.7140

MADRIX Version
MADRIX 5.0b

Release Date
July 2018

§ Added new supported LEDs: UCS8904.

§ Web Configuration: Updated the visual appearance for MADRIX 5.

§ Web Configuration: Network universes are now also shown in hexadecimal
notation in addition to the decimal notation.

§ Added 4 distinct options for sending data output in case of data connection
loss [only available in the web configuration tool]: Send The Last Received
Frame Continually, Send Black Frames Continually, Stop Sending After
Sending A Black Frame, Stop Sending.

§ Added support for Streaming ACN [sACN] for output.

§ You can now choose the network data source: Art-Net, Streaming ACN, or
Art-Net And sACN.

§ You can set the Start Channel for each port.

§ You can change the Channel Order for the output.

§ Added support for ArtSync.

NEBULA Firmware
1.04.7082

MADRIX Version
MADRIX 3.6h

Release Date
February 2018

§ Added new supported LEDs: UCS9812S.

§ Fixed a connection issue that did not report the device settings and status
correctly in the MADRIX Device Configuration dialog when only connecting
over Ethernet network.

NEBULA Firmware
1.02.7055

MADRIX Version
MADRIX 3.6g

Release Date
September 2017

§ Added new supported LEDs: GW6205.

§ Added new supported LEDs: SJ1221.

§ Added new supported LEDs: LPD1882S.

§ Added new supported LEDs: WS2815.

§ Fixed an important issue that allowed the device to only send with the
lowest, received frame rate, when receiving different frame rates for
different DMX universes on a single port. This behavior was mainly triggered
when used with a lighting console.
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§ Fixed an issue that correctly set Channels Per Universe in the web
configuration but still displayed the value as 'Automatic'.

§ Fixed an issue that did not set Channels Per Universe for Port 2 if USB as
well as Ethernet were connected and the settings was changed for both
ports in the MADRIX Device Configuration.

NEBULA Firmware
1.02.7035

MADRIX Version
MADRIX 3.6f

Release Date
May 2017

§ Added new supported LEDs: WS2811S.

§ Added supported LEDs: MBI6120, Limit 33 % [To limit the output to 33 % of
the possible maximum].

§ Added supported LEDs: MBI6120, Limit 66 %. [To limit the output to 66 % of
the possible maximum].

§ Fixed an issue with the following protocols that are now working correctly
again:
UCS1903, SK6822, P9883.

§ Fixed an issue that could leave the status LEDs permanently on when using
the ArtAddress functionality for Art-Net to switch from normal operation to
off while the status LEDs were currently active.

§ Fixed an issue that did not allow to select every 40th number of  the
Channels Per Universe setting. 

NEBULA Firmware
1.02.7014

MADRIX Version
MADRIX 3.6e

Release Date
February 2017

§ Added new supported LEDs: MBI6120.

§ Added new supported LEDs: WS2822S.

§ Added new supported LEDs: WS2822S Addressing [To linearly address LEDs
that haven't been initialized yet].

§ Added new supported LEDs: UCS512B3.

NEBULA Firmware
1.02.6346

MADRIX Version
MADRIX 3.6d

Release Date
December 2016

§ Added new supported LEDs: GW6201.

§ Added new supported LEDs: TM1814.

§ Added new supported LEDs: WS2813.

§ Added new supported LEDs: WS2818.

§ Changed name of supported LEDs: From TLS3001 To TLS3001 Linear.

§ Added supported LEDs: TLS3001 Quadratic [For 12-bit LEDs].

§ Output settings: Added the option to define the number of channels sent
per universe for each port [Channels Per Universe].

§ Sensor data: Devices can now report back if voltage is
connected/disconnected over USB [Voltage USB].

§ Sensor data: Devices can now report back which voltage is used for Power,
Port 1, and Port 2 [Voltage Power, Voltage Port 1, Voltage Port 2].

§ Sensor data: For NEBULA models V1.1 and higher, devices can now report
back the ambient temperature [Temperature].

§ Fixed an issue that could make the device become unresponsive under
certain circumstances when connecting, disconnecting, and calling up the
website several times in a row.

§ Fixed an issue that could produce display issues with the built-in web
configuration tool when confirming changes via 'Set'.

NEBULA Firmware
1.01.6168

MADRIX Version
MADRIX 3.6a

§ Web Configuration: Added Voltage to the Device Information section.

§ Web Configuration: Added the Refresh button to always show the latest
information that was last saved on the device in the web browser [instead
of using a browser refresh which may change settings again].

§ Web Configuration Streamlined spelling of output protocols.
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Release Date
July 2016

NEBULA Firmware
1.01.6147

MADRIX Version
MADRIX 3.6

Release Date
May 2016

§ Added new supported LEDs: P9883.

§ Added new supported LEDs: SK6812.

§ Added new supported LEDs: SK6822.

NEBULA Firmware
1.00.6127

MADRIX Version
MADRIX 3.6 RC

Release Date
May 2016

§ Initial firmware release.

5.2 Troubleshooting

This topic includes:

§ Important Information

§ Technical Advice

Important Information

§ In general, it is recommended to always activate all output universes. SPI communication is

based on strictly serial protocols, which means that data is always sent in succession. 

For example, when having output universe 1 and 4 activated and having output universe 2 and 3

deactivated, the data for output universe 4 will be sent directly after the data for output universe

1. 

Technical Advice

This section contains technical information that point out specific advice for certain LED types.

LED Technical Advice

§ WS2815 § LEDs of the type WS2815 normally require 12 V to work.
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§ MADRIX NEBULA offers a variety of wiring possibilities as shown in the MADRIX

NEBULA Technical Manual & Quick Start Guide.

§ Due to this variety of options, WS2815 might start to flicker when the data signal

from the NEBULA unit to the LEDs does not provide enough voltage in certain

ways of wiring.

§ The issue described above usually only becomes apparent when 12 V power is

supplied to the WS2815 LEDs as well as 5 V separately to NEBULA via an external

power supply, such as USB or USB power supply.

Then, the data signal from the NEBULA might fall below the required voltage to

control the LEDs due to the power loss from power input to data output.

§ If power is supplied separately, to NEBULA at 5 V and to WS2815 at 12 V, then it

is recommended to supply power of more than 5 V to the NEBULA (> 5 V) in order

to counteract the power loss and avoid data signal issues, which can result in

flickering on the LEDs.
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6 General

Topics Of This Chapter

§ Glossary

§ PC Power Management

§ Tips [Microsoft Windows / Networks / USB]

§ Web Links

6.1 Glossary

2D

MADRIX 5 makes it possible to control numerous LED fixtures, also of different kinds, and to position them

according to your needs in nearly any form or shape. This could be LED walls, arch shapes, ceilings, stripes,

tiles, dance floors, etc. You can control pixel by pixel [pixel mapping].

3D

MADRIX 5 supports volumetric pixel rendering as well [voxel mapping]. That means, MADRIX 5 also allows

you to control real 3D LED matrices. This approach is fundamentally different to the 3D projections or the

physical layout of 2D surface areas that are widely known nowadays.

Art-Net

Art-Net is a communication protocol that allows to distribute DMX512 data over Ethernet network. Often,

so-called Art-Net nodes then act as Ethernet-to-DMX512 converters and hardware interfaces. MADRIX LUNA

is such an Art-Net node, for example.

Art-Net Remote

Art-Net Remote refers to DMX512 input that is sent and received over Ethernet network.

CITP

Is another communication protocol for exchanging information, often used between media servers, lighting

consoles, and visualizers.
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Colorlight 5A, Colorlight A8, Colorlight T9, Colour Smart Link

Are network-based communication protocols to control compatible LED fixtures and classified as DVI-based

output in MADRIX 5.

DMX512 [DMX-OUT]

DMX512, often abridged to DMX, is an unidirectional communication protocol used mainly to control stage

lighting, which uses 5-pin XLR connectors as defined by the standard. 3-pin connectors are also common,

but not defined as standard connectors.

When working with DMX-based products, each fixture needs a specific attribution via its DMX channel and

its DMX universe. With the specific DMX channel and DMX universe, the LED product can be identified

directly for a correct communication with the fixture.

DMX-IN

You can send or receive DMX512 data. DMX-IN refers to DMX512 input, which you can receive in MADRIX 5.

DMX Channel

A total of 512 DMX channels is available per DMX universe. Each DMX channel is an individual control

channel. Valid values range from 0 to 255, with a total of 256 values.

DMX Universe

A DMX universe contains 512 DMX channels and represents 1 DMX line. To control more than 512 DMX

channels, more than 1 DMX universes need to be used. For example, 2 DMX universes represent 1024 DMX

channels.

For example, you can control 170 RGB fixtures per DMX universe. That means, calculating 170 fixtures x 3

channels results in 510 DMX channels. Therefore, channel 511 and 512 will be left empty.

And if your are using more then 170 fixtures, those DMX channels will be assigned to a new DMX universe

[e.g., DMX universe 2].

DVI

DVI is another way to output a video signal for your LEDs. Certain LED products use this type of

communication. MADRIX 5 features 2 DVI outputs, which are 1-to-1 output windows. You can then send the

DVI outputs to any graphics card port [such as, VGA, HDMI, DVI, etc.]. Other solutions use screen-capturing

to capture such a DVI output window and send them to the LED controller via Ethernet.
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Eurolite T9

Is a network-based communication protocol to control compatible LED fixtures and classified as DVI-based

output in MADRIX 5.

Fixture

When talking about an LED product, the specific product is often called fixture. When talking about fixtures,

often you will automatically get the information about the number of color channels [e.g., RGB] and the

number of pixels.

Input

MADRIX 5 can send data out, but at the same time data can be sent to the software. That means data is

sent to the MADRIX PC through various means [mostly USB or network]. MADRIX 5 can then be controlled

remotely by you, or you can merge or use incoming signals, etc.

IP Address

Is an identifier for devices that enables network communication. When using network protocols, it needs to

be set up for each individual sender or recipient in the network.

KiNET

KiNET, the Philips Color Kinetics network protocol, is another communication protocol. It transfers data over

Ethernet network as well. Only declared Philips Color Kinetics products work with this type of protocol.

MAC Address

Is a unique, technical identifier for interfaces in a network.

MA-Net

Is a proprietary communication protocol from MA Lighting between compatible products in a network.

MIDI

MIDI is short for Musical Instrument Digital Interface, a well-known technical standard that provides

standardized ways for equipment to communicate. In case of MADRIX 5, MIDI can be used for MIDI Time

Code, MIDI notes, or other MIDI hardware, such as DJ/VJ controllers.
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NDI

Network Device Interface is a network-based video technology by NewTek.

Output

To control your LEDs, MADRIX 5 needs to send data to the LEDs. In this way it communicates with your

controllers and/or your LEDs. This is referred to as output. There are different ways on how this process

can work [e.g., protocols]. But most importantly, you need to configure which output method MADRIX 5

should use in order to control your LED products.

Philips Hue

Is a proprietary range of products including communication protocol for personal wireless lighting made by

Philips Lighting.

Pixel

A pixel refers to one lighting point. When using RGB LEDs, one pixel usually includes 1 [or 2] red LEDs, 1

blue LED, and 1 green LED. 1 control channel is required for each color [3 in total per pixel], but as a total

they represent one pixel. LED fixtures often have a certain number of pixels per unit.

Pixel Mapping

MADRIX 5 contains an effect generator as well as a graphics render engine that support pixel rendering for

2D effects and volume rendering for 3D effects.

Remote HTTP

Remote HTTP is a way to control MADRIX 5 remotely using standards known from the internet [HTTP -

Hypertext Transfer Protocol].

RGB

The acronym stands for Red, Green, Blue. The 3 colors are the main colors for additive color mixing of LED

fixtures. As a result, a vast number of colors can be mixed.
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RGBW

The acronym stands for Red, Green, Blue, White. The 4 colors are also used for additive color mixing of LED

fixtures. As a result, a vast number of colors can be mixed.

Spout

Spout is a real-time video sharing framework for Windows.

Streaming ACN [sACN / E1.31]

Streaming ACN or sACN or E1.31 is another communication protocol that allows DMX512 data to be

transmitted over Ethernet. Data is broadcasted by MADRIX 5 to recipients in the network.

Subnet Mask

Is a technical grouping mechanism for network devices. When using network protocols, it needs to be set

up for each sender or recipient in the network for correct data routing.

Virtual LED Matrix

MADRIX 5 needs to know how your LED installation looks like and which fixtures you want to use. [You can

use the Matrix Generator or the Patch for this task.] In the end you will have configured the virtual LED

matrix with its total pixel count in X, Y, and Z set up as the Matrix Size as well as the position and location

of each pixel or fixture. The virtual LED matrix represents your LED installation in MADRIX 5.

Volume Rendering / Voxel Mapping

MADRIX 5 contains an effect generator as well as a graphics render engine that support pixel rendering for

2D effects and volume rendering for 3D effects.

Voxel

Voxel is short for volumetric pixel. In addition to its pixel mapping features [2D], MADRIX 5 can control 3D

LED matrices, which is called voxel mapping. Lighting effects are correctly mapped to each voxel of a 3D LED

matrix.

XLR Pin Layout

XLR connectors are used for DMX512. There are different types.
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5-Pin, Female 5-Pin Male Pin Assignment 3-Pin, Female 3-Pin, Male

1 Ground

2 Data -

3 Data +

4 Spare 

5 Spare

6.2 PC Power Management

This topic includes:

§ Why Is Power Management Important?

§ Usage

§ Activate High Performance

§ How To Change USB Power Settings

Why Is Power Management Important?

We strongly recommend to deactivate all power saving options in Microsoft Windows in order to

ensure an interruption-free operation of MADRIX 5.

Microsoft Windows operating systems offer a wide variety of power-management options. In most cases,

laptops, notebooks, and netbooks benefit from a longer battery life if a good power management is in use.

But certain problems might occur because of computer power savings nevertheless:

§ After a while your MADRIX KEY cannot be identified by the software anymore.

§ Your hardware interfaces are suddenly deactivated.

Usage

Make sure to set up power-saving settings especially if you are using:
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§ A MADRIX KEY [USB dongle]

§ MIDI controllers [via USB]

§ USB hardware interfaces [such as MADRIX NEO]

§ A notebook/laptop to run MADRIX 5

Additionally:

§ Make sure to change the USB power settings.

§ Especially for notebooks, we recommend to activate the High performance power plan. 

Activate High Performance 

This setting will make sure that your notebook or laptop will have all its potential performance available for

MADRIX 5.

§ In Windows 10, select Start > Windows System > Control Panel > Power Options, and change the

power plan to High performance

[You might need to click on Show additional plans].
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How To Change USB Power Settings

§ In Windows 10, select Start > Windows System > Control Panel > Power Options > Change plan

settings

§ Click Change advanced power settings
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§ Especially the USB settings are important. Disable the suspend settings! 
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§ Change any other settings that might interrupt the operation as required.

6.3 Tips [Microsoft Windows / Networks / USB]

This topic includes:

§ Error When Saving Files

§ USB

§ The Windows Firewall

§ Working With Ethernet Networks

§ Changing The Priority Of Network Adapters

§ Working With Files

§ Operating System Security

§ Up-To-Date Drivers

§ Windows Restart / Shut Down

§ Monitoring Computer Performance

Error When Saving Files

If you are experiencing issues when trying to save files, there are two solutions to this problem:

§ Right Click > Run as administrator

- In order to save files as a user that is logged-in into Windows, you need to have the permissions set

by Windows to do so. 

- When you do not have the right permissions, saving files can lead to errors.

- To circumvent such issues, you can run the MADRIX Software as administrative computer user, the

so-called administrator.

- Perform a right mouse click on the MADRIX.exe [or a shortcut to the MADRIX 5 Software] and

choose Run as administrator

- Note: You need to have access to the administrator account (i.e., password). Logging in as

administrator grants extensive rights for any computer changes. If you are not familiar with Windows

or computers, please seek advice.
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§ Choose A Different Directory

- When you are experiencing issues and running as administrator is not an option, choose a different

directory on your harddisk to save the files.

- There are locations on your computer/harddisk where you will have the permission to save files.

Choose such a location.

- Examples are:

C:\Users\USERNAME\Desktop

C:\Users\USERNAME\Documents

[USERNAME specifies your Windows account name.]

USB

Among others, USB is an important way to work with MADRIX 5, MADRIX KEYs, MADRIX hardware interfaces,

MIDI controllers, etc. In order to ensure a stable work environment, we highly recommend setting up

corresponding USB settings in Windows. 

Learn more »PC Power Management

The Windows Firewall

Correct Settings

The primary purpose for the Windows Firewall [or any other firewall] is to block any unwanted incoming or

outgoing data and access. But this can lead to problems, when data that should go through is
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automatically blocked.

MADRIX 5 will automatically set the correct firewall settings for you during the installation process. 

Please follow the steps below if this Windows message appears when you start the MADRIX 5 Software for

the first time. 

Select and set a checkmark for

§ Private networks

and

§ Public networks

§ Click Allow access to confirm.

Not selecting both options can cause problems with network communication.

Resetting The Settings

If you have already chosen the wrong options MADRIX 5, you can delete the settings and choose again.

§ In Windows 10, go to Start > Windows System > Control Panel > Windows Defender Firewall >

Advanced settings > Inbound Rules



[Part 6] General

//89www.madrix.com

MADRIX NEBULA User Manual



[Part 6] General

//90www.madrix.com

MADRIX NEBULA User Manual

§ Select and delete any entries relating to MADRIX 5 [e.g., madrix.exe, MADRIX - music makes the light,

MADRIX - LIGHTING CONTROL].

§ With your next start of MADRIX 5, select both options as described above.

Working With Ethernet Networks

Configuration Of Network Settings

When working with network-based products and MADRIX 5 [for example, Art-Net, KiNET, sACN, etc.], you

will have to set up the IP address of your network card in Windows. Learn how to set it up here.

§ In Windows 10, go to Start > Windows System > Control Panel > Network and Sharing Center >

Change adapter settings > Local Area Connection > Properties > Internet Protocol Version 4

(TCP/IPv4) > Properties
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Set up the following settings:

§ Enable Use the following IP address:

§ IP address - Sets the IP address for this computer and this network card. 

- If you have several network cars in your computer, you can set up an individual address for each

network card. 

- An IP address has 4 parts. Enter the complete address as explained in the specific chapter of this

user guide [e.g., 10.0.0.1]. 

- You only have to enter the numbers.

§ Subnet mask - Sets up the Subnet mask for this computer. 

- This is an important part of the network settings, just as the IP address. 

- A Subnet mask has 4 parts. Enter the complete address as explained in the specific chapter of this
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user guide [e.g., 255.0.0.0]. 

- You only have to enter the numbers.

§ OK - Click to save your settings. 

- [Make also sure to close the Local Area Connection Settings with OK and close the Local Area

Connection Status window with Close.]

§ Restart the MADRIX 5 Software if you have changed any network settings!

Learn more below.

Using Several Devices In A Network

Usually, you will use at least 2 devices in a network [for example, 1 MADRIX PC and 1 Art-Net node or 1

MADRIX PC and 1 console]. As explained above, you will need to configure various network settings not

only for your MADRIX PC but also for the other devices. 

To be able to communicate with each other, all devices have to be in "the same network". That means:

§ All devices need to be physically connected with each other [through network equipment, such as

hubs or switch and/or network cables]

§ All devices need to have compatible network settings

Using several devices in a network does not mean that all should have the same IP address. That will not

work! 

Instead, follow these rules:

§ Set up all devices within the same IP address range, but never with the same IP address 

[for example, MADRIX PC: 10.204.226.101 and Art-Net node: 10.204.226.102]

§ Set up all devices with the same Subnet mask e.g., 255.0.0.0]

§ If recommended, set up all devices with the same Default gateway [e.g., 10.0.0.1]

Changing The Priority Of Network Adapters

You can change the order in which Windows and MADRIX 5 accesses your network adapters. By changing

the order, you can specify which network adapter [network card] is used first and as the main connection. 

§ 1] In Windows 10, go to Start > Windows System > Control Panel > Network and Sharing Center

> Change adapter settings 
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§ 2] Press Alt on your keyboard.

- A menu appears at the top, which is otherwise hidden.

§ 3] Go to Advanced > Advanced Settings...

- A new window opens.
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§ 4] Select your preferred network connection[s] in the list of Connections:

§ 5] Change the order by clicking on the green up and down arrow buttons on the right hand side.

- The connection which is listed on top, is the first and prioritized adapter.

§ 6] Click OK to confirm.

§ 7] Restart your computer.

Working With Files

When working with computers in general, you should be aware that any digital data is sensitive and prone

to failure and hardware errors. 

We recommend

§ to save regularly when creating a show in MADRIX 5.

§ to make backup copies of your show files from time to time [MADRIX 5 Setup files]

§ to make backup copies to different or external storage mediums [e.g., USB stick/thumbdrive].
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Operating System Security

It is recommended

§ to keep Windows up-to-date by installing security updates using Windows Update

§ to use a virus detection software when working with files from external sources.

Up-To-Date Drivers

Please always keep all component drivers up to date by installing the latest available driver. Among others,

this may include drivers for:

§ Processor

§ Graphics Card

§ USB

§ Capture Card

§ Sound/Audio Card

§ Video Codecs

Windows Restart / Shut Down

According to the requirements of Windows, MADRIX 5 will behave in the following way:

§ MADRIX 5 will be closed instantly, when you trigger a Restart or Shut Down of Windows.

§ If you have not saved any changes yet, you may be provided the chance and a short time frame [30

seconds] to react and save your progress before the MADRIX 5 Software is forcefully closed by

Windows itself.

§ Make sure to save your files before executing a Restart or Shut Down!
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Monitoring Computer Performance

Windows allows you to monitor the overall performance of your computer. 

§ Press Ctrl + Alt + Del and choose Start Task Manager

[German shortcut: Strg + Alt + Entf]

§ A new window opens [Task Manager].

§ Go to Performance

§ You can now monitor the CPU Usage as well as the Memory usage. 

§ MADRIX 5 has its own monitoring tools.

6.4 Web Links

This topic includes:

§ Overview
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Overview

You can find a selection of useful internet links here:

§ MADRIX Website

»www.madrix.com

§ Drivers

»www.madrix.com/support/download

§ User Guides [Online And Downloadable PDF]

»help.madrix.com

§ Hardware Technical Manuals / Quick Start Guides [Downloadable PDF]

»help.madrix.com

§ Online Forum

»www.madrix.com/support/forum

§ Software Release Notes

»www.madrix.com/products/software/releases

§ Online Text Tutorials

»help.madrix.com/tutorials/html/index.html

§ Video Tutorials

»https://www.madrix.com/training/video-tutorials

https://www.madrix.com/
https://www.madrix.com/support/download
http://help.madrix.com/
http://help.madrix.com/
https://www.madrix.com/support/forum
https://www.madrix.com/products/software/releases
http://help.madrix.com/tutorials/html/index.html
https://www.madrix.com/training/video-tutorials
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7 Legal

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

Legal includes all legal documents and information, including copyright and more.

Topics Of This Chapter

§ Imprint And Copyright

7.1 Imprint And Copyright

This topic includes:

§ Company And Address

§ Copyright

§ Credits
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Company And Address

inoage GmbH

Wiener Straße 56

01219 Dresden

Germany

Managing Directors: Christian Hertel, Sebastian Pinzer, Sebastian Wissmann

Phone: +49 351 862 6869 0

Fax: +49 351 862 6869 68

Web: »www.madrix.com

E-mail: »info@madrix.com

Copyright

© Copyright (C) 2001 – 2024 inoage GmbH. All rights reserved.

MADRIX® is a registered trademark of inoage GmbH. 

All other company names and/or product names are trademarks and/or entered trademarks of their

respective holders. The product might not always be conforming to the presentation, features, and

performances. Technical data can differ slightly, depending on the operating system and the chosen

hardware. 

We withhold the option of changes without notification. inoage GmbH does not give any guaranty for

function capability for a certain purpose, the marked ability or other features of the product. No other

guaranty claims, on legal or other terms, can be enforced. 

Under no circumstances does inoage GmbH take on the responsibility for liabilities for faults for losses in

sales volume or profits, that occur through the usage of the product, through the serviceability, through

http://www.madrix.com
mailto:info@madrix.com
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abuse, happenings, circumstances or actions, that we have no influence on. No matter if the damages were

caused by the holder of the product or a third person.

Credits

§ Art-Net™ - Designed by and Copyright Artistic Licence Holdings Ltd.

§ Other product and company names, terms, or [trade] marks are the property of their respective

holders.
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